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Prerequisites:
Units 1–9

	 Learning Activities Sheet

	 Student Name __________________________________________________

	� Place a checkmark in the appropriate box as you complete each of the steps 
below.

	 ❏	 1.	 Take	� Pretest provided by instructor. After test has been 
evaluated, follow instructor’s recommendations.

	 	 ❏	 2.	 Read	 Objective Sheet.

	 ❏	 3.	 Study	� Information Sheet, Objectives 1 through 4, and Student 
Supplement 1, “Pull-Down Menus in Adobe Illustrator.”

	 	 ❏	 4.	 Research	� Online resources to learn more about vector illustration 
software and how it is used in the advertising and 
design field. Your instructor will provide you with a list 
of relevant Web sites. Write the Web addresses on the 
blanks below and visit at least two of them.

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 ❏	 5.	 Study	� Information Sheet, Objective 5.

	 	 ❏	 6.	 View	� Online tutorials demonstrating how to use the various 
tools located in Adobe Illustrator or the illustration 
software used on site. Visit http://tv.adobe.com/channel/
how-to/ as one source for online tutorials. 

	 ❏	 7.	 Study	� Information Sheet, Objectives 6 and 7.
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	 	 ❏	 8.	 Research	� Online to find ways to customize your Adobe Illustrator 
(or illustration software used on site) panels. Write 
down four ways below that you could customize various 
panels to increase your productivity. 

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 ❏	 9.	 Study	� Information Sheet, Objectives 8 and 9.

	 	 ❏	 10.	 Research	� Keyboard shortcuts online for the illustration software 
and platform (Mac or PC) you are working on. Or, create 
your own list from the shortcuts featured in the drop-
down menus located on the menu bar in your illustration 
software. Keep a list of all of your keyboard shortcuts 
where they are easily accessible until you have them 
memorized. Write five of the keyboard shortcuts that you 
will use most often in the spaces below. 

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 •	 _________________________________________________

	 	 ❏	 11.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 1.

	 ❏	 12.	 Do	� Job Sheet 1, “Create Line Art By Tracing a Template and 
Editing Paths.”

	 ❏	 13.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 14. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 1 and repeat steps 9, 11 and 12.

Learning Activities Sheet



MAVCC—Advertising and Design	 Page 10–5

	 ❏	 14.	 Study	� Information Sheet, Objective 10.

	 	 ❏	 15.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 2.

	 ❏	 16.	 Do	� Job Sheet 2, “Apply Color, Hierarchy and Type to 
Information Graphics.”

	 ❏	 17.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 18. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 2 and repeat steps 14 through 16.

	 ❏	 18.	 Do	� Assignment Sheet 1, “Examine Creative Concepts Used 
to Design Menus, and Sketch a Menu Panel.”

	 ❏	 19.	 Stop	� Have instructor evaluate the completed assignment 
sheet and if the evaluation is satisfactory, continue to 
step 20. If the evaluation is not satisfactory, repeat step 
18.

	 	 ❏	 20.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 3.

	 ❏	 21.	 Do	� Job Sheet 3, “Redesign a Steakhouse Restaurant Menu 
With Organized Text Using Menus and Panels.”

	 ❏	 22.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 23. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 3 and repeat steps 20 and 21.

	 ❏	 23.	 Study	� Information Sheet, Objective 11.

	 ❏	 24.	 Do	� Assignment Sheet 2, “Examine Creative Concepts for 
Bottle Labels, and Sketch Bottle Label Designs.”

	 ❏	 25.	 Stop	� Have instructor evaluate the completed assignment 
sheet and if the evaluation is satisfactory, continue to 
step 26. If the evaluation is not satisfactory, repeat step 
24.

Learning Activities Sheet
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	 	 ❏	 26.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 4.

	 ❏	 27.	 Do	� Job Sheet 4, “Create 2D and 3D Bottle Illustrations.”

	 ❏	 28.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 29. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 4 and repeat steps 23, 26, and 27.

	 ❏	 29.	 Study	� Information Sheet, Objective 12.

	 	 ❏	 30.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 5.

	 ❏	 31.	 Do	� Job Sheet 5, “Create Custom Blends.”

	 ❏	 32.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 33. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 5 and repeat steps 29 through 31.

	 	 ❏	 33.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 6.

	 ❏	 34.	 Do	� Job Sheet 6, “Create an Expressive Typography Design 
With Transparency and a Mask.”

	 ❏	 35.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 36. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 6 and repeat steps 33 and 34.

	 	 ❏	 36.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 7.

	 ❏	 37.	 Do	� Job Sheet 7, “Create a Trap and Prepare Color 
Separations for Printing With PMS Colors.”

Learning Activities Sheet



MAVCC—Advertising and Design	 Page 10–7

	 ❏	 38.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 39. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 7 and repeat steps 36 and 37.

	 ❏	 39.	 Do	� Assignment Sheet 3, “Research Color Psychology, and 
Sketch Logo Designs for a Deli.”

	 ❏	 40.	 Stop	� Have instructor evaluate the completed assignment 
sheet and if the evaluation is satisfactory, continue to 
step 41. If the evaluation is not satisfactory, repeat step 
39.

	 	 ❏	 41.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 8.

	 ❏	 42.	 Do	� Job Sheet 8, “Create a Deli Logo and Apply It to 
Stationery.”

	 ❏	 43.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 44. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 8 and repeat steps 41 and 42.

	 	 ❏	 44.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 9.

	 ❏	 45.	 Do	� Job Sheet 9, “Prepare a Logo for Print and Web.”

	 ❏	 46.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 47. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 9 and repeat steps 44 and 45.

	 ❏	 47.	 Do	� Assignment Sheet 4, “Examine Creative Concepts 
Used to Design Promotional Products for a Non-Profit 
Organization, and Sketch Newsletter Layouts.”

	 ❏	 48.	 Stop	� Have instructor evaluate the completed assignment 
sheet and if the evaluation is satisfactory, continue to 
step 49. If the evaluation is not satisfactory, repeat step 
47.

Learning Activities Sheet
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	 	 ❏	 49.	 Observe	� Demonstration of procedures to be used in completing 
Job Sheet 10.

	 ❏	 50.	 Do	� Job Sheet 10, “Design a Newsletter for a Non-Profit 
Organization.”

	 ❏	 51.	 Stop	� Have your instructor evaluate your performance and 
if the evaluation is satisfactory, continue to step 52. If 
the evaluation is not satisfactory, study the procedure 
outlined in Job Sheet 10 and repeat steps 49 and 50.

	 ❏	 52.	 Take	� Posttest provided by instructor. After test has been 
evaluated, follow instructor’s recommendations.

	 ❏	 53.	 Stop	� Have instructor evaluate your unit performance. If the 
evaluation is satisfactory, continue to step 54. If the 
evaluation is not satisfactory, repeat steps 3, 5, 7, 9, 14, 
23 and 29.

	 ❏	 54.	 Check	� With instructor for any additional assignments to be 
completed.

	 ❏	 55.	 Do	� Additional assignment or job sheets listed below.

				    _________________________________________

				    _________________________________________

				    _________________________________________

	 ❏	 56.	 Take	� Unit Review provided by instructor.

	 ❏	 57.	 Stop	� Have instructor evaluate your unit performance. If the 
evaluation is satisfactory, proceed to next learning 
activities sheet. If evaluation is not satisfactory, ask 
instructor for further instructions.

	 *Permission to duplicate this learning activities sheet is granted.

Learning Activities Sheet
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	 Objective Sheet

Unit
Objective

	� After completing this unit, the student should be able to use vector illustration 
software to design and create vector-based graphs, graphics and illustrations 
for print and Web-based advertising. The student will demonstrate these 
competencies by completing the assignment sheets and job sheets and by 
scoring a minimum of 85 percent on the written test.

Specific
Objectives

	 After completing this unit, the student should be able to:

	 	 1.	 Match terms related to vector illustration to their definitions.

	 2.	 Complete statements concerning vector illustration software.

	 3.	� Select true statements concerning the functions of vector illustrations in 
advertising and design.

	 4.	� Match basic features of vector illustration software to their descriptions.

	 5.	� Match tools used in vector illustration software to their icon or function.

	 6.	� Select true statements concerning points, paths, shapes and direction 
handles.

	 7.	� Match basic panels used in vector illustration software to their functions.

	 8.	� Select true statements concerning methods of moving groups of 
objects.

	 9.	� Complete statements concerning methods of organizing graphics and 
text.

	 10.	� Select true statements concerning working with text in vector illustration 
software.

	 11.	 Complete statements concerning 2D and 3D art.

	 12.	 Select true statements concerning custom blends and masks.

	 13.	� Examine creative concepts used to design menus, and sketch a menu 
panel. (Assignment Sheet 1)

	 14.	� Examine creative concepts for bottle labels, and sketch bottle label 
designs. (Assignment Sheet 2)

	 15.	� Research color psychology, and sketch logo designs for a deli. 
(Assignment Sheet 3)

MAVCC—Advertising and Design	 Page 10–9
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	 16.	� Examine creative concepts used to design promotional products for 
a non-profit organization, and sketch newsletter layouts. (Assignment 
Sheet 4)

	 17.	 Create line art by tracing a template and editing paths. (Job Sheet 1)

	 18.	 Apply color, hierarchy and type to information graphics. (Job Sheet 2)

	 19.	� Redesign a steakhouse restaurant menu with organized text using 
menus and panels. (Job Sheet 3)

	 20.	 Create 2D and 3D bottle illustrations. (Job Sheet 4)

	 21.	 Create custom blends. (Job Sheet 5)

	 22.	� Create an expressive typography design with transparency and a mask. 
(Job Sheet 6)

	 23.	� Create a trap and prepare color separations for printing with PMS 
colors. (Job Sheet 7)

	 24.	 Create a deli logo and apply it to stationery. (Job Sheet 8)

	 25.	 Prepare a logo for print and Web. (Job Sheet 9)

	 26.	 Design a newsletter for a non-profit organization. (Job Sheet 10)

Objective Sheet
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	 Vector Illustration10
	 Information Sheet

	 Objective 1	 Terms and definitions

	 ✔ �Note:	 Please refer to the Key Terms for definitions.

	

Fill
Identity system
Line

Perspective
Stroke
Vector

	 Objective 2	 Vector illustration software

Key Terms

Fill—The positive space of a shape created by applied color
Line—A point set in motion
Vector—Graphic created by a continuous point and line; can be scaled 
up or down

	 a.	� �Vector illustration software is used to create computer-generated 
illustrations through the use of point, line and fill.

	 Figure 1—Vector illustration

	

line

point

fill

	 b.	� When creating an image in vector illustration software, approach it as if 
you were building an illustration rather than drawing it.
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Information Sheet

	 Objective 3	 Functions of vector illustrations in advertising and design

Key Term

Identity system—With the basis of a distinct logo, a defined color panel 
and typographic treatments, this system provides presentation unity 
across a broad range of marketed materials

	 a.	� Vector Illustrations can easily be scaled up or down in size for use in 
many applications of an identity system.

	 b.	� Vector illustrations can be exported for use in print or animation, or on 
the Web.

	 Objective 4	 Basic features of vector illustration software

	 ✔ �Note:  As you study this objective, view the various features of the illustration 
software available on site on your monitor.

	 Figure 2—Document window showing basic illustration software features

	

Menu bar
Control panel

GRID
(non-printing)

Ruler
guides

Tools
panel

ARTBOARD

Panels

Panel
options
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	 a.	� Artboard—The blank, outlined area that represents a page where 
graphics are created

	 b.	� Control panel—Large bar usually positioned at the top of the program, 
featuring a sample of the most commonly used panel settings

	 c.	� Grid—A non-printing background grid used to lay out elements in an 
organized manner

	 d.	� Menu bar—Pull-down menus that drop down when selected by mouse 
or keystroke

	� ✔ �Note:	 A right facing arrowhead to the right of menu items indicates 
that there are more choices related to the given menu item.

	 e.	� Panel options—Panel menu icon in upper-right corner of panel that 
contains drop-down menu of options and settings for that panel

	 f.	� Panels—Movable menus that allow the designer to adapt and change 
the attributes to software tools and functions

	 g.	� Ruler guides—Rulers marked off in various units of measure that 
appear as guides to the illustrator but do not print out on the artwork

	 h.	� Tools panel—Menu of tools available to select, create and manipulate 

Information Sheet
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	 Objective 5	 Tools used in vector illustration software and their functions

	 ✔ �Note:  The screenshots in this objective were taken in Adobe Illustrator CS5.  

Icon Tool Name Function
Selection tool Used to select and move whole line 

segments or shapes

 
Direct Selection tool Used to select points to distort, edit 

and manipulate established lines and 
shapes

Magic Wand tool Used to select areas similar to the area 
the user clicks on with the mouse

✔ Note: More or less of an area can 
be selected by changing the tolerance 
settings of this tool.

 
Lasso tool Used to select an area with a click/drag 

motion of the mouse

  
Pen tool Used to connect points with lines in 

a “connect the dots” fashion; most 
accurate method of drawing a shape

 
Type tool Used to type text onto the artboard

 
Line Segment tool Used to combine the creation of two 

points and a line in one tool in order to 
create lines with a click/drag motion

 
Rectangle tool Used to create simple, whole rectangle 

shapes with a click/drag motion

✔ Note:  Other shapes can be found 
by clicking and holding down this tool 
button in the Tools panel.

 
Paintbrush tool Used to simulate the artistic strokes of a 

paintbrush with a continuous click/drag 
motion on the screen

 
Pencil tool Used to create a solid, sketch-like line 

with a continuous click/drag motion on 
the screen

 
Blob Brush tool Used to paint filled shapes that can 

intersect and merge with other shapes 
of the same color.

 
Eraser tool Used to erase an area of a shape

Information Sheet
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Icon Tool Name Function

 
Rotate tool Used to create a custom 2D rotation on 

the screen

	✔ Note: After selecting the shape with  
the Selection tool, then selecting this 
tool, the user can click on the corner of 
an object to create a custom 2D rotation 
on the screen.

 
Scale tool Used to scale an object by clicking and 

dragging the corner of an object

✔ Note: The dragging motion must go 
toward or away from the object’s center.

 
Width tool Used to create a variable width stroke 

that can be saved as a profile to be 
applied to another stroke

Free Transform tool Used to rotate, squash, stretch or scale 
an object, depending on the direction 
the active points are pulled

 
Symbol Sprayer tool Used to add symbols that follow the 

path the user’s mouse has taken

 
Shape Builder tool Used to create complex shapes by 

merging and erasing simpler shapes; 
contains the Paint Bucket tool

 
Perspective Grid 
tool

Used to draw directly on planes of true 
perspective, to draw shapes and scenes 
in accurate 1, 2, or 3-point perspectives, 
and to move, scale, duplicate and 
transform objects dynamically

 
Column Graph tool Used to create graph bars, including pie 

graphs

 
Artboard tool Used to re-size artboards

 
Slice tool Used specifically for defining Web 

spaces

 
Mesh tool Used to create advanced, realistic 

looking gradients on whole shapes 
within an illustration

 
Gradient tool Used to apply a gradient to a shape

 
Eyedropper tool Used to instantly set the fill color to the 

area that was clicked on in an image

Information Sheet
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Icon Tool Name Function

 
Blend tool Used to create a series of intermittent 

morphing shapes between two objects

 
Hand tool Used to click/drag the artboard to move 

it around the screen

 
Zoom tool Used to zoom in on an object for a 

closer on-screen view

Fill, Stroke and 
Toggle tools

Used to apply a new fill color to a shape, 
to add a stroke to a shape and to swap 
the colors of a shape

	 Objective 6	 Points, paths, shapes and direction handles

Key Term

Stroke—An outline color, width or style (brush stroke, dashed, dotted)

	 a.	� Points

	 •	 Points are used to connect lines.

	 •	 Points can be moved when selected with the Direct Selection tool.

	 b.	� Paths

	 •	 �Paths are made up of anchor points (for editing) and line segments.

	 •	 Paths can be open (line) or closed (shape).

	 •	 �A closed path is a shape that has a stroke (outline) and fill (center).

	 •	 �Paths can be changed by selecting points and lines with the Direct 
Selection tool.

	 c.	 Shapes

	 •	 �Shapes are closed paths that may have stroke and fill applied.

	 •	 �The simplest method of creating an illustration is to use the 
appropriate shape tool on the Tools panel to create an overlapping 
group.

	 •	 �When creating a shape, hold down the Shift key to create shapes 
that are perfectly even in height or lines that are perfectly straight.

	 •	 �It is important to close shapes. Objects that are not closed may 
appear to be closed; however, you will have little control over effects, 
outlines and fills when shapes are not truly closed.

Information Sheet
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	 d.	� Direction handles

	 •	 �Direction handles are straight lines that connect to points and align 
with the direction the points were plotted.

	 •	 �Direction handles are used to change existing curves in a shape 
by moving either end of the direction handle while in Direct Select 
mode.

	 •	 Direction handles are usually located near curves.

	 Objective 7	 Basic panels used in vector illustration software and their functions

	 a.	� Layers panel—Allows the user to name and stack shapes, offering 
organization and control over the illustration; layers can be individually 
moved, edited, turned on or off, deleted, duplicated, merged, locked or 
hidden and also be part of a larger illustration

	 Figure 3

	

	 b.	� Align panel—Allows the user to align shapes, lines and text vertically or 
horizontally

	 Figure 4

	

Information Sheet
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	 c.	� Character panel—Allows the user to choose a different font and to 
change the size and spacing associated with the font

	 Figure 5

	

	 d.	� Color panel—Allows the user to choose a color system and change the 
stroke or fill in the Tools panel

	 Figure 6

	

Information Sheet
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	 e.	� Swatches panel—Provides the user with a “color bank” of swatches that 
can be moved from the Color panel and used in an illustration

	 Figure 7

	

	 f.	� Brushes panel—Allows the user to choose from various sizes and styles 
of brushes to create graphic patterns and fine art strokes when applied 
to the Brush tool

	 Figure 8

	

Information Sheet
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	 g.	� Symbols panel—Allows the user to create and store their own graphics 
for repeated use or to use various themed libraries of ready-made 
graphics

	 Figure 9

	

	 h.	� Transform panel—Aids in the transformation of shapes by rotating, 
shearing or mathematically scaling the height and width when the 
desired units of measurement are entered

	 Figure 10

	

Information Sheet
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	 Objective 8	 Methods of moving groups of objects

	 a.	� Shift > Select objects to be moved

	 •	 �This method is a quick way to repeatedly move objects that may not 
need to be moved together as part of a specific group.

	 •	 �Once the selection has been cleared, it is easy to immediately work 
with the elements.

	 b.	 �Object > Group located on the menu bar

	 •	 �This method is a semi-permanent way to move objects around the 
artboard.

	 •	 �Grouping items allows them to be moved together by selecting only 
the items you want with the Selection tool or marquee.

	 •	 �Once objects are grouped, they will stay together until they are 
ungrouped.

	 •	 �Adjusting elements within groups takes a little longer since they must 
be ungrouped before any edits can occur.

	 c.	� Expanded menu of Layers panel > Merge Selected

	 •	 �This method will merge elements from different layers onto one 
layer.

	 •	 �This method allows objects to be turned on and off or to 
simultaneously apply transparency to an object.

	 •	 �By clicking on the target in the right area of the layer, all objects can 
be temporarily grouped and edited.

	 Figure 11—Expanded Menu of Layers Panel

	

Information Sheet
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	 Objective 9	 Methods of organizing graphics and text

	 a.	� Copy and paste an object.

	 •	 Edit > Copy and then Edit > Paste from the menu bar

 	 •	 �PC—Hold down Control-Alt keys while dragging an object

	 •	 Mac—Hold down Option key while dragging an object

	 •	 Keyboard shortcuts

	 —	 Mac shortcuts

	 –	 Apple-C to copy

	 –	 Apple-V to paste

	 —	 PC shortcuts

	 –	 Control-C to copy

	 –	 Control-V to paste

	 b.	 Select all elements on a page.

	 •	 �Shift > Manually select elements—Allows user to select specific 
elements in various layers

	 •	 �Marquee selection—Allows user to quickly select elements on the 
artboard that are near each other by using the Selection tool to drag 
a marquee around elements

	 •	 �Edit > Select All from the menu bar—Allows user to quickly select all 
elements on the artboard

	 c.	 Use the Align panel.

	 •	 �Shift > Manually select elements and then choose a method of 
alignment from the Align panel—Allows user to align elements 
horizontally or vertically

Information Sheet
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	 Objective 10	 Working with text in vector illustration software

	 a.	� Text wrap can be used to create a barrier of space between text and 
an image that text surrounds. This barrier creates separation and 
organization and can be adjusted in the Text Wrap options.

	 b.	� Text can flow through many text blocks on one page via connected text 
boxes in illustration software. This is helpful when creating an ad with 
multiple columns of body copy or a one-page newsletter.

	 c.	� During the design process, designers are constantly changing and 
editing text. The connected text boxes allow the text to automatically 
reflow through the design whether text is added or deleted.

	 d.	� When creating multiple-page documents, use page-layout software 
rather than illustration software.

	�� ✔ �Note:	  QuarkXPress and Adobe InDesign are the industry standards 
for page-layout software.

	 Objective 11	 2D and 3D art

Key Term

Perspective—Use of scale, color and value to show depth

	 a.	� 2D art

	 •	 �2D art is created using simple perspective drawings with attention 
to line weight and appropriate gradients.

	 •	 �Thicker lines tend to relay closeness, while thinner lines relay 
distance.

	 •	 �Gradients that are light at the bottom and dark at the top relay 
distance�.

	 b.	 3D art

	� ✔ �Note: Use the 3D function sparingly, because Adobe Illustrator 
automates the repeated duplication process of the line, making the 
3D art file very large and causing older computers to work very slowly 
or shut down.

	 •	 �3D art is created with illustration 3D effects.

	 •	 �Images to be used in 3D art must be drawn as flat art or line art and 
beveled or revolved.

	 •	 �3D images show mass, volume, shadows and highlights.

Information Sheet
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	 •	 �3D images allow the user to choose from multiple angle and side 
views.

	 •	 �3D images can only be created in CMYK color mode, because the 
3D process automatically adds black to shading and reverts any 
image to CMYK.

	 •	 �Illustration software will try to rotate the lines and surface of a 
closed and filled shape 360°, resulting in a distorted, twisted image. 
Therefore, it is important to think of shapes as outlined halves for 
rotation.

	 Objective 12	 Custom blends and masks

	 a.	� Custom blends

	 •	 �Allow one object to transform into another object through sequential 
stages.

	 •	 �The same object can be blended into a different scale to show 
perspective, or two different objects can be blended to show total 
transformation.

	 b.	� Masks

	 •	 �Applying a mask is much like applying a cookie cutter to a body 
of text, another shape or a photo. The area the mask is applied to 
remains intact but takes on the outer perimeter of the mask.

Information Sheet
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	 Vector Illustration10
	 Student Supplement 1—Pull-Down Menus
	 in Adobe Illustrator

	� ✔ �Note: The screenshots in this supplement were taken in Adobe Illustrator 
CS5. Open Adobe Illustrator or the illustration software available in your 
classroom. View the menu bar and pull-down menus on your monitor and 
notice where the pull-down menus are located and also notice the various 
functions available within each menu option. If you are using illustration 
software other than Adobe Illustrator, you should note where these options 
are in your particular software.

	 a.	� Menu bar

	

	 b.	� Illustrator pull-down menu	 c.	 File pull-down menu
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	 d.	� Edit pull-down menu	 e.	 Object pull-down menu

		

	 f.	� Type pull-down menu	 g.	 Select pull-down menu

		

Student Supplement 1
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	 h.	 Effect pull-down menu	 i.	 View pull-down menu

	

	 j.	 Window pull-down menu	 k.	 Help pull-down menu

		

Student Supplement 1
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	 l.	� Preferences menu (located under the Illustrator pull-down menu on the 
menu bar)

		

	

Student Supplement 1


